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DSS Installation

1. Introduction

This document is part of training modules for the Nile Basin Decision Support System (DSS).
These modules are developed for use in classroom training that is given to Nile Basin
countries and as a self-learning training material that will be made available as part of the

DSS helpdesk and knowledgebase.
1.1. Purpose
The purpose of this document is to provide a tutorial to the DSS installation process.

1.2. Module prerequisites

The following prerequisites are needed before taking this tutorial:

Software prerequisites: Windows 7, 8 or 8.1.

User prerequisites: User is expected to be familiar with program installation procedure on

Windows but this is not essential.

1.3. Expectations

Upon successful completion of this module, you will have learnt how to setup the DSS
components successfully on your computer. A fully installed and functional DSS can be
conceptualized by three major components illustrated by red boxes in the diagram below.

'ﬁﬁ? Software Layout and mefﬂ

DSS application

HEEEE ST

Modalmg Tools




DSS Installation

1.4. Conventions

The following conventions are followed in this document:

means a tip for the user

O

I

4 means important information

1.5. Module data

The files needed to install the DSS are located in the ..\ DSS_Setup folder.

1.6. Links to additional resources

In addition to the information presented in this module, below are links to additional
resources that you can access to obtain further information on the following:
o Mike By DHI:
= http://www.mikebydhi.com/
e PostgreSQL:
= http://www.postgresqgl.org/
e PostGIS

= http://postgis.net/

1.7. Problem Reporting Instructions

This document will be updated regularly. Therefore, it is highly recommended to report any

spotted problem to helpdesk@nilebasin.org so it can be corrected in future versions. When

reporting the problem, you are kindly requested to provide the following:
e Document title
e Document version
o Page number where the problem was spotted

o A description of the problem
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2. Lessons

In this section the following lessons are included:

e General: This lesson introduces you to the various installation requirements of the

DSS Software. It covers the following:

1. Minimum hardware requirements including OS recommendations

2. User privileges

3. Software Prerequisites

4. Licensing requirements

o DSS installation: This lesson takes you through the DSS installation process. This
includes:

1. MIKE Zero Installation (Includes installation of Mike 11 and Mike Hydro)

2. MIKE by DHI License installation (Stand-alone/Network)

3. PostgreSQL Database Installation on Windows and configuring PostgreSQL
on Windows to allow remote connections (only for Corporate version under
Windows)

4. PostGlIS installation on Windows

DSS installation

After completing the lessons in this section you will have installed the DSS

successfully on your computer.
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2.1. General
Introduction

This lesson introduces you to the various installation requirements of the DSS Software. If

you are familiar with those requirements you can skip this and move to the next lesson.

Topics covered in this lesson:
e  Minimum hardware requirements
e  User privileges
o  Software prerequisites

e Licensing requirements

Lesson objectives:
After completing this lesson, you will be able familiar with:

e The various installation requirements of the DSS Software
Minimum hardware requirements

The recommended minimum system requirements to install the DSS are:

o ti Fully supported operating systems *
perating Windows 7 Professional Service Pack 1 (32 and 64 bit), Windows 8 Pro (64 bit) and
systems Windows Server 2008 R2 Standard Service Pack 1 (64 bit).

Processor 2.0 GHz Intel Pentium or higher

Memory )
2 GB (or higher)
(RAM)
Hard disk 40 GB (or higher)
Monitor SVGA, resolution 1024x768 in 16 bit color

Graphics 64 MB RAM (256 MB RAM or higher recommended), 24 bit true

adapter color

et DVD drive compatible with dual-layer DVDs is required for
edia
installation

File system  NTFS

Ports One USB port for the DSS hardware key
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DSS Editions and installation privileges

The DSS comes in two editions, the 'Professional’ and the 'Corporate’. For the 'Professional’
edition, the server is the same machine. For the 'Corporate’, there is a centralized database
server where postgress and postgis reside. A professional edition can be turned into

corporate by allowing others to connect to the database server.

The installation of both editions does require administrative privileges.

Software Prerequisites

In addition to the Operating system requirements specified above, the DSS requires
Microsoft .NET Framework 4.0 to be installed. To install Microsoft .Net Framework 4.0, you
should locate it from the prerequisites folder on the MIKE By DHI DVD or download a copy

from the Internet from http://www.microsoft.com/en-us/download/details.aspx?id=17851.

Licensing requirements

In order to use the DSS, you have to obtain the following:

* A hardware key (Dongle)

» Alicense file that is associated with the above hardware key.
The hardware key and its associated license file can be obtained from the NBI secretariat
and they can be used for either the 'Professional’ or the ‘Corporate’ editions. A hardware key

can hold more than one license for the corporate edition.
Review Questions

1. The DSS can run on Windows XP.

= True

= False
2. What are the two editions of the DSS? Explain the differences between them.
3. The DSS has no software prerequisites.

= True

= False?
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Answers

1. False (it can run but it is not supported by DHI, i.e. if a problem occurs, it cannot
be reported as it may be caused by incompatibility).

2. The DSS comes in two editions, the 'Professional’ and the 'Corporate’. For the
'Professional’ edition, the server is the same machine. For the 'Corporate’, there
is a centralized database server where postgress and postgis reside. A
professional edition can be turned into corporate by allowing others to connect to
the database server.

3. False (It requires Microsoft Windows 7, 8 or 8.1 and .NET Framework 4.0).

Page 8



DSS Installation

2.2. DSS installation

Introduction

This lesson takes you through the DSS installation process.

Topics covered in this lesson:

MIKE Zero Installation (Includes installation of Mike 11 and Mike Hydro)

MIKE by DHI License installation (Stand-alone/Network)

PostgreSQL database installation on Windows and configuring PostgreSQL on Windows
to allow remote connections which is needed only for NB DSS Corporate edition under
Windows (See for DSS editions section for details).

PostGIS installation on Windows

DSS installation

Lesson objectives:

By the end of this lesson, it is anticipated that you will be able to install the DSS and all its

associated programs successfully.

Lesson prerequisites

None.

An overview of the DSS installation

A number of different software packages are required in order to install and run the
DSS. These are:
» Modeling tools such as MIKE 11 and MIKE HYDRO to run simulations. These
are part of the MIKE by DHI 2014 version.
= PostgreSQL 9.1 which acts as the database server
» PostGIS 2.0 which acts as the GIS extension to PostgreSQL.

The PostgreSQL database server can either be installed on the same machine for the
'Professional’ edition whilst it can be installed on a server machine for the 'Corporate’

edition.
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Installation of the above packages should happen before proceeding with installation of
the DSS. All of the modeling tool installers offer to switch DHI ‘Autoupdate’ on, but when

used with the DSS, It is advised not to do so, in order to ensure a compatible installation.
Installation process

In the following sections, a step by step DSS installation tutorial is presented. Please note
that this installation was undertaken under Windows 7 32-bit edition. Installation on other

operating systems and/or architectures may vary.

Exercises

MIKE Zero Installation

Open the .\ DSS_Setup\Data\MikeByDHI folder. Right-click on ‘Setup’ (or ‘Setup.exe’ if file

extensions are shown in windows Explorer) and select 'run as administrator':

E » D55 Setup » Data » MikeByDHI »

Dlder
Mame

MIKE Zero 32 bit

| Releaze Motes

The following window appears with the different setup options:
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MIKE by DHI Software Setup

Product Overview

MIKE URBAN

DHI Network License Manager

MIKE C-MAP

Instal
MIKE Zero (32 bit)

Exit Software Setup

E PRODUCT

Introduction

need to know in order to install and get started with Release 2014
‘With MIKE Zero you have

* MIKE 21 (release note)
& MIKE 3 (release note)
* LITPACK (release note)
& MIKE 11 (release note)
= MIKE SHE (ielease note)
* MIKE FLOOD (release note)
& MIKE HYDRO (rglease note)
Also included with MIKE Zero are:
& DHIRemote Simulation (release nole)
« DHIWaterData (12lease note)
* MIKE Animator Plus (release note)
& MIKE View (release note)

Release Note 2014 MIKE Zero

‘Welcome to MIKE Zero Release 2014 In this Release Note you will find information about new features of MIKE Zero, and what you

Click ‘MIKE Zero' then click ‘Install Mike Zero (32 bit)'. If you are installing 'MIKE Zero' on a
64-bit machine from a DVD, this installer by default will install the 64-bit version of 'MIKE
Zero' which is not compatible with DSS v2.0. In such case, you should force the 32-bit

version by running setup from inside the “Mike Zero 32 bit version” folder in the DVD.

The following dialog appears Click ‘Next'.

1] DHI MIKE Zero 2014 3:

SOFTWARE FOR
WATER ENVIRONMENTS

MIKE"

by DHI

Welcome to the InstallShield Wizard for DHI
MIKE Zero 2014 32 bit

The InstallShield{R) Wizard will install DHI MIKE Zero 2014 32
bit on your computer. To continue, dick Mext.

WARMIMG: This program is protected by copyright law and
international treaties,

< Back [ Mext = ] [ Cancel
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Read and accept the terms in the license agreement and click ‘Next'.

DHI MIKE Zero 2014 32 bit - InstallShield Wizard I X
Please read the following license agreement carefully. MI KE
DHI
You are about to install one or more DHI copyrighted MIKE i
|| software products L4

After completion of this installation the product(s} will operate az Demeo Version(s), unless a
licence file and dongle iz provided with the installation (on a separate media) or yvou have

Ul |purchased a full license. The Demo Version is provided by DHI for evaluation purposes only.
Any other use of the software requires that you obtain a licence from DHI and accept the
MIKE by DHI licence conditions.

| |If you have already obtained a licence and a dongle from OHI or if you have purchased a full
l license and want to enable the Full Version of the software, then please read the following

4 rmdAarmtmmd B ommd mmess e b bemdA ke e daremn med mmm AR A ms F s mem s -

I 1 I do not accept the terms in the license agreement

InstallShield

(@) I accept the terms in the license agreement

[ < Back [ Mext = _] [ Cancel

Make sure that Mikel1 and Mike Hydro are both selected to be installed as shown below

and click ‘Next’.
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Custom Setup

£\
Select the program features you want installed. MIKE

iy DA

Click on an icon in the list below to change how a feature is installed.

Feature Description

MIKE 11 - a system for the 1D
modelling of rivers, channels and
irrigation systems.

MIKE 3
- = = | MIKE FLOQD

== | MIKE 5H
E,! MIKE HYDRO

¥ - | Femote Simulation Server Components

This feature requires 1552KE on
your hard drive. Ithas 2of & -4
subfeatures selected. The
subfeatures require 111MB on
your hard drive.

Install to:
C:\Program Files\DHI\20 14, Change...
Installshield
|  Hep || space ][ <Back | Next> ||| cancel |
L
-

The license selection dialog appears.

7
14 DHI MIKE Zera 2014 32 bit - InstallShield Wizard M
MIKE by DHI License selection ﬁﬂ
vy ErHLE

@ Unchanged. Keep current form of license management

I
() Demo. Mo license file will be installed

I () Local. License file will be installed locally on the PC

() Metwork. Licenses are requested from & central server

i Installshield

<Back | MNext> || Cancel

There are four license options:
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1. Unchanged: this means you already have a valid DHI license installed

2. Demo: This means you want to run the program in demo mode (i.e. limited in
features and capabilities)

3. Local: This means you already have a license file but it is not installed

4. Network: This means licenses are installed on a server

In this case select |@ Local. License file will be installed locally on the PC| and click ‘Next':

ﬁ DHI MIKE Zero 2014 32 bit - InstallShield Wizard El

MIKE by DHI License selection

P
Select license type M.I I(E.“\]I

DHI

(71 Unchanged. Keep current form of license management

(71 Dema., Mo license file will be installed

[l‘l Local. License file will be installed locally on the PCI

() Metwork, Licenses are requested from a central server
1"

InstaliShield -

[ < Back [ Mext = ] [ Cancel ]

The local license dialog appears, select ‘Local copy’ and click ‘Browse’ to select the DHI

license file! then click ‘Next'.

! Contact the Nile Basin Secretariat to obtain this license file provided that you are entitled for a license. A USB
dongle is also required.
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MIKE by DHI Local License Z—‘ﬁ
Bty by i el e MlKDE
) Internet

If you do not yet have your DHI license file, choose this option. plug in your DHI
dongle, you will be prompted to download the license at the end of the installation.

(@) Local Copy

If you have a DHI License file on your PC, choose this option.

!D:\,DhiLicense.dat < Browse

Installshield

| <Back Next> | canel |

The ‘Auto Update Configuration’ dialog appears, uncheck? ‘Enable DHI Auto Updater to run

as startup’ and click ‘Next'.

] DHI MIKE Zero 2014 32 bE - InstallShield Wizard o
| DHI Auto Updater ﬁ
Select automatic updates MI I(q.}E

DHI Auto Updater will automatically keep your DHI products updated with the
newest Service Packs. The DHI Auto Updater can be run automatically when
the computer is started

I [ Enable DHI Auto Updater to run at Windows startup? I

Installshield

<Back [ Mext> ||| cancl

2 When new services packs or updates are available, it is not recommended to install them unless DHI advises to
do so. NBI-SEC will advise you on that.
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The following dialog appears. Click ‘Install’ to start installation.

) DHI MIKE Zero 2014 32 bit - InstallShield Wizard [
e o

Ready to Install the Program Pﬁ
The wizard is ready to begin installation. MIKE

DHI

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

[ < Back

F Install } [ Cancel

The installation dialog providing progress information appears.

=]
14) DHI MIKE Zero 2014 32 bit - InstallShield Wizard e

Installing DHI MIKE Zero 2014 32 bit ﬁ'
The program features you selected are being installed. M.I KE

o DI

Please wait while the InstallShield Wizard installs DHI MIKE Zero 2014 32 bit.
Thiz may take several minutes.,

Status:

I Copying new files

Installshield

< Back Mext = Cancel
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When finished the following dialog appears. Ensure that the program was installed

successfully and click ‘Finish’.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed DHI MIKE
Zero 2014 32 bit, Click Finish to exit the wizard,

SOFTWARE FOR
WATER ENVIRONMENTS

MIKE"

by DHI

< Back Cancel

A new folder called ‘MIKE by DHI 2014’ is now created under ‘All Programs’ in the ‘Start

menu’.

. MIKE by DHI 2014 B
E DHI License Administration
<32 DHI License Updater
<3} DHI Software Updater

DHI Rernote Simulation

. DHI WaterData

. MIEE Animator Plus

. MIKE View

, MIKE Zero

m

MIKE by DHI License installation (Stand-alone/Network)

Installing and configuring Mike by DHI license is done using the DHI License Manager
accessible via Windows Start Menu under MIKE by DHI menu (here shown in version
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2014). This is needed to ensure that the dongle is linked to the license file you have

installed.

Stand-alone License installation

Right click on & DHI License Admi“istratiﬁd under the Mike by DHI 2014 group and

select 'Run as administrator'.

. MIKE by DHI 2014
@ DHI License Administration
<5 DHI License Updater
<3 DHI Software Updater
. DHI Remote Simulation
.. DHI WaterData
. MIKE Animator Plus
J. MIKE View
. MIKE Zero

m

Make sure the license server is running:

<% DHI License Administration
B Start/Stop License Service | lsage | License

Service State

@) Start Service

) Stop Service

Advanced Settings ...

Click on ‘License Mode Control’ tab:

<% DHI License Administration u

| & Start/Stop License Service | Usageil License Mode Control |l ogging | System Information |

License Mode Selection

@ Local Mode { License file is installed locally on the PC )
.angle Mumber
install icense fle.. | N/A

(71 Metwark Maode ( License is requested from a central DHI Netwark License Manager )
DHI Metwork License Manager
Connect...
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Insert the DHI hardware key (or dongle) in a USB port and click on ‘Local Mode'. After a few

seconds the dongle should be installed and recognized.

<% DHI License Administration

€ |

© Start/Stop License Service | Usage | License Mode Cortrol | Logging | System Information

License Mode Selection
@ Local Mode ( License file is install

Install license file..

(7 Network Mode { License is requested from a central DHI Network License Manager )
DHI Network License Manager

Dongle Number
MZ-24303

Connect...

Go back to the ‘Start/Stop Licenser Service’ tab, click the ‘Test Service’ button.

a

=% DHI License Administration

© Start/Stop License Service | IUsage | License Mode [

Service State

@ Start Service @ Running

7 Stop Service

Test Service

Advanced Settings ...

If installation of the license is successful you should get the following message:

DHI License Administrati... EE |

s
IOI Test Successful
. _/
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Network License installation

To use a Network License, you need to click the Network Mode button instead of the local
mode that was selected in above section. You need also to specify the name of the

computer on which the DHI Network License Manager is installed.

First right click on [fd DHI License Administration| ynder the Mike by DHI 2014 group

and select 'Run as administrator'. Switch to the 'License Mode Control' tab and select

'Network Mode".

<% DHI License Administration

@ Start/Stop License Service | License Mode Control | Logging I System Irrfunﬂatiun|

License Mode Selection

™ Local Mode ( License file is installed locally on the PC )
Dongle Mumber

l Install license file..

@ Metwork Maode { License is requested from a central DHI Netwark License Manager )
DOHI Metwork License Manager

l Connect... ]

Software Dopale

Click the 'Connect..." button

Connect to Remote Server M

Remote Server Connection

Server Name/IP address:  dellserver? -

Remaote Server Port: B&&S =

In the above window, specify the server name where the license is installed or its IP address.
By default server port where the license is installed is '8888'. Leave it if it is correct otherwise
change to the correct port. Click the 'Test' button to check whether the settings are correct or
not. If the settings are correct the following message appears confirming that the test is

successful.
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Connect to Remote Ser... ﬁ

'01 Test Successful

If not you receive the following message which means you need to correct you inputs.

T:,‘:onnei:t to Remote Server Error

==
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PostgreSQL Database Installation
In this section, it is assumed that you have not previously installed the PostgreSQL

database. If you have any previous version of PostgreSQL installed, you must remember
the password used when installing that version before proceeding with the current
installation process. If you cannot remember the password used in the previous

installation, you have to delete the postgres user account from your system.

Open the ..\ DSS_Setup\Data folder. Right click on ‘postgresql-9.x.x-windows’ (or ‘postgresql-

9.x.x-windows.exe’ if file extensions are being shown) and select 'Run as administrator'.

s b D55 Setup » Data »

Burn Mew folder

| | MikeByDHI

[% postgresql-9.1.5-l-windu:rws]
E?ﬁ postgis-pgdl-setup-2.0.0-3
5 Nile Basin DSS 2.0

Some prerequisites may be automatically installed. In such case a dialog similar to the

one below appears.

TE—

Microsoft Visual C++ 2008 Redistributable - x86 9.0.30729.4148

| Please wait while Windows configures Microsoft Visual C+= 2008
$ Redistributable - x86 5.0.30725 4143 ..




DSS Installation

After all prerequisites are installed the following dialog appears. Click ‘Next'.

& Setup @Eﬂ
Setup - PostgreSQL
Welcome to the PostgreS0L Setup Wizard.
PostgreSQL
b_","'.'
EnterprisenR°
| <rack ||[ met> ||[ cancel

The installation directory dialog appears, accept the default ‘Installation Directory’ by clicking

‘Next'.

e Setup

Installation Directory

Flease specify the directory where PostgreSQL will be installed.
Installation Directory | C:\Program Files\PostareSQLYS. 1 I

BitRock Installer

< Back

Mext = l
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The data directory dialog appears, accept the default ‘Data Directory’ by clicking ‘Next’.

& Setup

m@'ﬂ

Data Directory

Please select a directory under which to store your data.
Data Directory| :\Program Files\PostgreSQL13. 1\data

BitRock Installer

< Back l

[ Mext >

Cancel

The password dialog appears, Type in a password? of your choice and click ‘Next'.

& Setup

[EERIERTC)

Password

1

|
¥

account does not exist, it will be created when you dick ‘Mext'.

Password

Retype password

Please provide a password for the database superuser {postgres) and service account (postares). If the
service account already exists in Windows, you must enter the current password for the account. If the

BitRock Installer

[<Badc]

[ Mext =

o)

The port dialog appears; accept the default ‘Port’ and click ‘Next'.

¥ Note your password as it shall be used later in the process
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& Setup

Port 5432

Please select the port number the server should listen on.

BitRock Installer

[<Bad<]

[ wext> || cance |

The advanced option dialog appears, select ‘English, United States’ instead of the

default ‘Locale’ and click ‘Next’.

e = .
& Setup ‘@Elﬂ
Advanced Options E ﬁ

Select the locale to be used by the new database duster.

I Locale [English, United States

)|

BitRock Installer

<gack || mext> || cancel

The ‘Ready to Install’ dialog then appears; click ‘Next’ to start installation.
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I;
A setup ESREERT)

Ready to Install Lﬂ
B =

Setup is now ready to begin instaling PostgreSQL on your computer.

BitRodk Installer

[ <taac ][ voc> ][ conc

The installation dialog providing progress information appears.

& Setup Em

Installing [’&

Please wait while Setup installs PostgreSQL on your computer.

Installing
Unpacking C:\Program Files\PostgreSQLYa. 1\bin'pg_archivedeanup.exe

BitRock Installer

o ) [ o> (o)
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When installation is done, the following dialog appears.

. Completing the PostgresSQL Setup Wizard

Setup has finished installing PostgreSQL on your computer,
Launch Stack Builder at exit?

Stack Builder may be used to download and install
additional tools, drivers and applications to
complement your PostgreSQL installation,

PostgreSQL

D J:J"r-".'

Enterprise

The Ervtarpriss

< Back |[ Finish ]| Cancel

Uncheck ‘Launch Stack Builder at exit?’ then click ‘Finish’ to finalize the installation.

PostgreSQL

Packaged by:

EnterprisepB

The Enterprise Postares Corpany

& Sctup B a0

(el

Completing the PostgreSQL Setup Wizard

Setup has finished installing PostgreSQL on your computer,

O

Launch Stack Builder at exit?
Stack Builder may be used to download and instal|
additional tools, drivers and applications to i
complement your PostgreSQL installation.

e |[Cm)

Cancel
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A new program group called ‘PostgresSQL 9.1’ is now created under ‘All Programs’ in the ‘Start

menu’.

" PostgresQL 9.4
& Application Stack Builder
ﬁ pgbdmin IT
C} Reload Configuration
W SQL Shell (psql)

| Documentation

Starting the PostgreSQL admin

Start ‘PgAdmin III' by clicking on ‘Windows Start’ menu, followed by ‘All Programs’, then
‘PostgreSQL 9.1' and finally ‘pgAdmin III'.

.. Postgre5QL9.1
e Application Stack Builder

» Reload Configuration
(& Sl Shell (p=qgl)

1. Documentation

The main PgAdmin window appears.

WW pghdmin I 'ﬂ L “

I

= | Els
File Edit Plugins View Tools Help
-TIT PR
i Ly
; =y |
ik X | Properties | Statistics [ Dependencies | Dependents | ¥
Servers (1) Properties
B PostoresQL 8.1 (ocalhost: 5432}' *=|No properties are available for the current selection
AN HE b
5QL pane x
< | [l 3
r Refrieving details on servers... Done. 0.00 secs
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Double click on the node for the server (it should be the only one) named PostgreSQL 9.1
(localhost:5432). Type in the password for the PostgreSQL user and check ‘Store password’.
Click ‘OK.

# Connect to Server w

Please enter password for user postgres
on server PostareSQL 9, 1 {localhost)

|7 Store password

o oot ]

The following dialog appears to warn you that the password is stored in plain text (i.e. can be
seen by any one). Click ‘OK’. Note that saving the password helps you later in accessing the
database server either directly or using the Database Manager Utility. Therefore, for a local
installation saving the password is not very unsafe but on a server, the server administrator

should be cautious about it.
r"y' Guru Hint - Saving passwords ‘ " '

Saving passwords

WARNING: You have opted to save your password. It will be stored in plain text
in your home directory on *nix systems, or in your user profile on Windows . If you
do not want this to happen, please press the Cancel button.

pgAdmin uses PostgreSQL's ‘pgpass’ mechanism to store your passwords. On
*nix systems, the password will be stored in ~/pgpass, whilst on Windows
systems it will be stored in 2%6APPDATA % \Posfgre SQL \pgpass. conf
(%APPDATASS is the "Application Data’ folder in your user profile). This
mechanism is used by default by all programs that use the libpg library to access
the server, which includes command line applications such as pg_dump and
pg_restore, other GUI applications, and drivers such as psqlODBC. This means
that those applications may automatically connect to the server using your stored
password. If you do not want this to happen, you should not use the Sfore
Password option in pgAdmin.

[7] Do not show this hint again

Help oK ] [ Cancel
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A connection to the server is established and pgAdmin shows the contents of the database.

P
W pgAdmin I

1]

File Edit Plugins View Tools Help

Server Groups
EIE Servers (1)

=B PostoresoL 9.1 (ocalhost: 5432)
(-]~ Databases (1)
El*':?: Tablespaces (2)
Group Roles (0}
4 Login Roles (1)

|| Properties | Statistics

| Property

= Description
:=|5ervice
‘=|Hosthame
:=|Host Address
:=|Part

- = Encryption

:=|85L Certificate File

Installation on Linux

Configure PostgreSQL and Windows to allow remote connections (only for

Corporate edition under Windows)

In a Professional Edition where the PostgreSQL service is a local database service for

programs in the same machine the settings are by default appropriate.

The following section is only relevant for situations where the Windows machine with the

database shall act as a central server to many clients. In that case some the following settings

need to be modified:
e Windows Firewall

e PostgreSQL service

Firewall

By default the firewall of a Windows machine is restrictive with respect to what and who can

gain access to the resources. It is therefore necessary to configure the firewall to permit

access to the PostgreSQL service.

The procedure below describes how to open up for incoming traffic on the PostgreSQL port

from any machine.
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From the Control Panel click on Windows Firewall

Control Panel Home

Allow a program or feature
through Windows Firewall

'@U Change notification settings

'&U Turn Windows Firewall on or
off

Restore defaults

e
Advanced settings |

roubleshoot my |

See also
Action Center
Metwork and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your

computer through the Internet or a network,

How does a firewall help protect my computer?

What are network locations?

@ For your security, some settings are managed by your system administrator,

Update your Firewall settings

Windows Firewall is not using the
recommended settings to protect your
computer,

What are the recommended settings?

[ @ Use recommended settings

Click advanced setting and choose Inbound Rules in the Next dialog

i = = . e e
@ Windows Firewall with Advanced Security P—

“SE— >
- e o

Eile  Action

s

View Help

Inbound Rules
&8 Outbound Rules

» B, Monitoring

@ Windows Firewall with Advance

5’; Connection Security Rules

MName

nchCache Content Retrieval (HTTP-]
. BranchCache Hosted Cache Server (HTT...
@ BranchCache Peer Discavery (W5D-In)
. Connect to a Network Projector (TCP-In)
. Connect to a Network Projector (TCP-In)
@ Connect to a Network Projector [WSD Ev..
. Connect to a Network Projector (WSD Ev...
. Connect to a Network Projector (WSD Ev...
@ Connect to a Netwark Projector (W5D Ev.
. Connect to a Network Projector (WSD-In)
@Cora Networking - Destination Unreacha...
@Core Metworking - Destination Unreacha...

@Core Metworking - Internet Group Mana...
() Core Netwarking - IPHTTPS {TCP-In)

(@) Core Networking - IPvé (IPvé-In)

@Core Networking - Multicast Listener Do..,
(@) Core Metworking - Multicast Listener Qu...

8 nre Matinrbina  Mlticact Lickanar Ran
RN 1

@) Core Networking - Dynamic Hast Config...
@Cora Networking - Dynamic Host Config...

B

Profile Enabled

Group

BranchCache - Content Rets

BranchCache - Hosted Cach.. All MNo
BranchCache - Peer Discove...  All No
Connect to a Network Proje...  Private.. No
Connect to a Metwork Proje..  Domain Mo
Connect to a Network Proje..  Domain  No
Connect to a Metwork Proje...  Private.. Mo
Connect to a Network Proje..  Domain = No
Connect to a Metwork Proje...  Private.. MNo
Connect to a Metwork Proje... Al No
Core Networking All Yes
Core Metworking Al Yes
Core Metworking All Yes
Core Networking All Yes
Core Metworking Al Yes
Core Metworking All Yes
Core Networking All Yes
Core Networking All Yes
Core Metworking Al Yes
e Mabunrinna An Var

Inbound Rules

m |

Filter by Praf...
Filter by State

View
Refresh
2. Export List..

Help

K Delete
Properties
Help

4
»
Filter by Group »

4

Click the ‘New Rule’ in the menu to the right. This opens a Rule Wizard. Select ‘Port’

type and click ‘Next'.
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P B
§9 New Inbound Rule Wizard . - - .. lﬂ

Rule Type
Select the type of firewall rule to create.
Steps:
& Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action ) Program
& Frifie Rule that controls connections for a program.
@ MName @ Port

Rule that controls connections for a TCP or UDFP port.

' Predefined:
BranchCache - Contert Retneval (Uses HTTF)
Flule that controls connections for a Windows experience.
(! Custom
Custom rule.
Leam more about nile types
Back Neadt Cancel
B e | |
| % — — !J

Specify the TCP port for PostgreSQL (as used for the PostgreSQL installation, but typically
5432). Click Next.

P B
§ New Inbound Rule Wizard . - - .. lﬂ
Protocol and Ports
Specify the protocols and ports to which this rule applies.
Steps:
@ Rule Type Does this rule apply to TCP or UDP?
@ Protocol and Ports @ ICP
@ Action 71 UDP
@ Profile
@ Name . .
Does this rule apply to all local ports or specific local ports?
) All local ports
@ Specific local ports: b432
Example: 80, 443, 5000-5010
Leam more about protocol and ports
<Back || Nea> |[ cancel
| - ——

The rule should allow access on this port. Click Next
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f §9 New Inbound Rule Wizard .. @‘

Action

Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps:
@ Rule Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Ports =
y @ Allow the connection
o This includes connections that are protected with [Psec as well as those are not. I
@ Profile .
. (©) Allow the connection if it is secure it
Name
- This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.
"1 Block the connection

Leam maore about actions

Select all profiles and click ‘Next'.

P ™
§&9 New Inbound Rule Wizard . . - - ﬁ
Profile
Specify the profiles for which this rule applies.
Steps:
@ Rule Type ‘When does this rule apply?
@ Protocol and Ports
@ Action [¥] Domain
@ Prific Applies when a computer is connected to its corporate domain.
@ Name [¥] Private
Applies when a computer is connected to a private network location.
[¥] Public
Applies when a computer is connected to a public network location
Leam more about profiles
[ <Back [ Net> ][ cancel |
|
Y —

Enter a name and description of the rule and click ‘Finish’.
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&9 New Inbound Rule Wizard

Name

Steps:

@ Rule Type

@ Protocol and Ports
@ Action

Praofile

&

@ Name

Specify the name and description of this rule.

Name:

PostgreSGL (5432)

Q_esc:_'iption_{option;_l}:

J [L_Fiish

] [ Cancel

r T——
@ Windows Firewall with Advanced Security i

P

Eile Action VYiew Help

= 2FE = HE

0 Windows Firewall with Advance
3 Inbound Rules
Outbound Rules
E‘b Connection Security Rules
1+ % Monitoring

Froomaraes e —

Enabled *

Name

'/ PostgreSQL (5432)

@ airPort

GAItap Salamander, File Manager
GAItap Salamander, File Manager
@ Bonjour tjeneste
@Eonjourtjeneste
@Eonjuurtjene;te

@ Bonjour tjeneste
@Conne:tn’y

@Connemfy

(@ Dropbox

@Dropbox

@druphox.exa

(@ dropbox.exe

@Intamet Explorer

@Internet Explorer

@Java(TM) Platform SE binary
) Java(TM) Platform SE binary
(8 Java(TM) Platform SE binary

(8 13202 (TR Diabfnrmn GF hinans
1

4

Profile
All

All
Public
Public
Private
Private
Private
Private
Public
Public
Private
Private
Public
Public
Private
Private
Private
Public
Public

Driniate

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Ver

E

RS
@3 NewRule.

Y Filter by Prof... »
F Filter by State b
Y Filter by Group »
View »
Refresh

Export List...

Sl

Help

PostgreSQL (5432)
& Disable Rule

& cut

52 Copy

x Delete
Properties

Help

Now the new rule is visible in the list of Inbound rules.

PostgreSQL Service

The database service itself also includes an access permission system which by default

only allows local access from the same computer. For the server to work as a server in a

network environment the permissions must be opened up.
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To set up the server to allow access any machine, the following should be done: Open

pgAdmin and connect to the database service (as explained starting the PostgreSQL

admin).

Open menu item Tools -> Server Configuration -> pg_hba.conf
e

Object browser

File Edit Plugins View Help

il 5

14 server Groups

E-F servers (1)
[ERr W FostoresaL s. 1 (o
|/ Databases (2)

£ Tablespaces (2)

Group Roles (1)
L. Login Roles (1)

Rule enabled?
Trigger enabled?
Disable triggers
Enable triggers

Validate foreign key

Slony Replication
Connect

Disconnect

Disconnect

Start Service

Stop Service

Reload cenfiguration
Pause replay of WAL
Resume replay of WAL
Add named restore point
Debugging

Query tecl

Scripts

View Data

Reports

Maintenance...
Backup...
Backup globals...
Backup server.
Restore...

Grant Wizard.

Server Configuration
Run now

Server Status

L

pendencies | Dependents |

value

PostgreSQL 8.1

Iocalhost

5432
not encrypted

postgresql-9.1
postgres

postgres

Yes

No

PostgresQL 8.1.5, compiled by Vi
9.1

11905

Yes

31/10/2014 04:20:12
31/10/2014 04:20:08
running

no

postgresql.conf

pg_hba.conf

| B

The ‘Backend access configuration Editor’ window appears. Double-click the empty line

and configure remote access.

|

) Backend Access Configuration Editor - C:/Program Files (x86)/PostgreSQL/9.0/data/p.. oo

File Edit Help

NEPNE PE

Type Database User IP-Address
¥ host  all all 127.0.0.1/32
¥ host all all 1:1/128

r

4| m

Configuration read from localhost

The ‘Client Access Configuration window’ appears. Fill the data as shown below. Click ‘OK’

and save the configuration.
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[ :=| Client Access Configuration = C
Enabled
Type [host v]
Database all -
Lser all -
IP Address  0.0.0.0,0
Method [inds -]
] Help oK ] [ Cancel

Finally click File->Reload Server to activate the new settings. Verify the settings by

connecting with pgAdmin from another machine in the network (if possible).
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PostGIS Installation

Open the ..\ DSS_Setup\Data folder. Right click on * postgis-pg91-setup-2.0.0-3' (or

.0.0- ‘ postgis-
pg91-setup-2.0.0-3.exe’ if file extensions are being shown) and select 'run as administrator

Please note that the PostGIS file name shows the compatible Postgres version. For example

appears, click ‘l agree’.

. , if
postgres 9.0 is installed, postgis 2.0 for postgres 9.0 should be installed. The following dialog

@ PostGIS 2.0.0 for PostgreSQL 9.1 Setup

(= S

for PostgreSQL 9. 1.

l %‘ () Please review ﬁ'le license terms before installing PostGIS 2.0.0

Press Page Down to see the rest of the agreement.

(4
Copyright (C) 1989, 1991 Free Software Foundation, Inc

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed

GNU GEMERAL PUBLIC LICENSE
Version 2, June 1991

Preamble

The licenses for most software are designed to take away your

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install PastGIS 2.0.0 for PostgreSCL 9. 1.

[ ragee J[[ concel |

@ PostGIS 2.0.0 for PostgreSQL 9.1 Setup

2

Choose Components

Y Q Choose which features of PostGIS 2.0.0 for PostgreSQL 9. 1 vou
want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue,

Select components to install:

Description

] L.reate.spahal database |

Space required: 72.8MB

A T S
Mullsaft Install Syste

< Back Mext = Cancel

The software components selection dialog appears, it is recommended to leave ‘Create spatial
database’ unchecked. Click ‘Next'.
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Accept the default ‘Destination Folder” by clicking ‘Next’.

@

=
g PostGIS 2.0 for PostgreSQL 91 Setup . s M e |

- Choose Install Location

0 Choose the folder in which to install PostGIS 2.0.0 for
PostgreSQL 9.1,

Setup will install PostGIS 2.0.0 for PostgreSQL 9. 1in the following folder. To install in a
different folder, dick Browse and select another folder. Click Mext to continue.

Destination Folder

:\Program Files\PostgreSOLY9. 1

l Space required: 72.8MB
Space available: 6.6GE

Mullsoft Install Swstem 2,46

| <Back Next> || [ cancel

)

The database connection dialog appears. Type in the password of the postgres user (the

same as during PostgreSQL database installation). Click ‘Next’ to start installation.

@ PostGIS 2.0.0 for PostgreSQL 9.1 Setup: Database Connection s
@
] Database Connection
|| 0 Spedify the database connection
Database Connection Information
User Name:  postgres
Password: | seeess
Port: 5432
Mullsoft Install System vz 46
ll <Back || mext> ||| cancel
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The installation dialog providing progress information appears.

@ .
@ PostGIS 2.0.0 for PostgreSQL 9.1 Setup o S|

a
a Installing
s o Please wait while PostGIS 2.0.0 for PostgreSQL 9. 1is being
' installed.

Extract: postgis-configure.patch... 100%
-—

Mullsoft Install System vz 46

< Back Close Cancel

When installation is completed, the following message appears. Click ‘Yes'.

r
@ PostGIS 2.0.0 for PostgreSQL 9.1 Setup

Would you like us to register the GDAL_DATA environment variable for you,

settings if you have them.

needed for raster transformation to work properly? This will owverwrite existing

|
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The following dialog appears, click ‘Close’ to finish installation.

|

{4 PostGIS 2.0.0 for PostgreSQL 9.1 Setup

@
F- Installation Complete
o Setup was completed successfully,

Completed

Mullzoft Install System w2, 46

< Back Close i | cancel

A new program group called ‘PostGIS 2.0 for PostgresSQL 9.1’ is now created under ‘All Programs’

in the ‘Start menu’.

| PostGI5 2.0 for PostgreSQL 9.1
€ PostGIS 2.0 Manual On-Line
e PostGIS 2.0 Shapefile and DEF Loade
%L PostGIS 2.0.0 PDF Documentation
& PostGIS Documentation On-Line
E PostGIS IDBC Driver On-Line Docurr
€ PostGIS Website
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DSS installation

Open the .\ DSS_Setup\Data folder. Double click on ‘Nile Basin DSS 2.0’ (or ‘Nile Basin DSS

2.0.msi’ if file extensions are being shown).

s kb D55 Setup » Data »

urn Mew folder

Mame

| | MikeByDHI

i postgresgl-9.1.5-1-windows
@ postgis-pgdl-setup-2.0.0-3
(157 nile Basin DS 2.0

The following dialog appears, click ‘Next’ to start the installation.

|:||_

Welcome to the Nile Basin DSS 2.0 Setup
Wizard

The Setup Wizard will install Mile Basin D35 2.0 on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.

Back [ Mext J [ Cancel
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Read and accept the license agreement. Click ‘Next’.

5 Mile Basin DSS 2.0 Setup ==

o A m -E-'mE' nt

z :eadﬂ':e fnlm:g license agreement carefully

MIKE Customised License Agreement

This is a legal agreement (Agreement) between the Client, the end -user
and the Contractor concerning the use of MIKE Customised Products and
Components - hereinafter MCPC.

BY INSTALLING OR USING THE DELIVERED MIKE CUSTOMISED SOLUTION OF
WHICH THE MCPFC I5 A PART, YOU ARE AGREEING TO BE BOUND BY THE TERMS
OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, PROMPTLY UMIMSTALL THE MCPC AND RETURN THE UNCPENED
PACKAGE TOGETHER WITH THE ACCOMPANYING ITEMS (WRITTEMN MATERIALS,

[¥]1 accept the terms in the License Agreement

-

| pint | [ Bak [ mext || | cancel

The Custom setup dialog appears, click ‘Next’ to install:

I
i The Mile Basin D55 program files
[
i
| This feature requires 187MB on
your hard drive,
o e | 3

E I
1) Nile Basin DSS 20 Setup Ml s S L2 - i)

Location: C:\Program Files\DHI'Mile Basin DSSY,

[ e | ok ][ sk [|_vex )| G
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Now you are ready to install the DSS, click ‘Install'.

1) Nile Basin DSS 2.0 Setup

Click Install to begin the installation. Click Back to review or change any of your |
installation settings. Click Cancel to exit the wizard.

The setup progress dialog appears.

4 Nile Basin DSS 2.0 Setup sl

Please wait while the Setup Wizard installs Nile Basin D55 2.0,

Status:

Back | Next | | cCancel ]
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The following dialog appears. Ensure that setup is completed. Click ‘Finish’ to close

the installer.

-
4 Nile Basin DSS 2.0 Setup

Completed the Nile Basin DSS 2.0 Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Back . Cancel

A new folder called ‘Nile Basin DSS’ is now created under ‘All Programs’ in the ‘Start

menu’.

. Mile Basin D55
1 Database Manager Utility

P8 Nile Basin DSS

@ MIKE CUSTOMISED Platform API Do
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Review Questions

1. What software packages need to be installed with the DSS?
2. DHI licenses can be local or on a network.

o True

e False
3. PostGIS handles spatial data for postgreSQL.

e True

e False
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Answers

1. A number of different software packages are required in order to install and run the
DSS. These are:
= Modeling tools such as MIKE 11 and MIKE HYDRO to run simulations.
= PostgreSQL which acts as the database server
* PostGIS which acts as the GIS extension to PostgreSQL.
2. True.
3. True.
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3. References

- Nile Basin Decision Support System help file (DSS Ver. 2.0)

- Nile Basin Decision Support training material (developed in 2013 and 2014)

- DHI training material for the Nile Basin Decision Support (developed in 2012)
- DHI NB DSS 1.2 - Installation guide (Developed in 2013).
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